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Making Word Forms 
This guide will take you through how to use Microsoft® Word 2007 to create forms that 

users can complete online, save and attach in an email. 

A good knowledge of Microsoft Word 2007 is assumed, for example, using built-in 

heading styles and inserting section breaks. Further guides can be found at 

www.bradford.ac.uk/lss/documentation/#Wordprocessing. 

Some visually impaired people use screen reader software, which reads out the 

information on web pages and in documents. This guide will help you to ensure that your 

forms are accessible to this group of users. 

ALTERNATIVE FORMATS 

As with all documentation, you must offer your form in an alternative format. The most 

accessible format is html, so it‟s worth carefully considering the type of form you require 

and whether it could be placed directly on a web page, e.g., 

http://www.bradford.ac.uk/lss/feedback.php. If you decide this format is suitable, please 

contact the Web Team (web-team@bradford.ac.uk). In this case you would not require an 

alternative format. 

If you decide you require a Word form, then you must provide an alternative (pdf), as 

some users may not have Microsoft Office on their machine. Unfortunately, you cannot 

simply save your Word form as a pdf, because the interactive input fields will not be 

converted (users will not be able to click into the pdf and type into it). Currently, we do not 

have the resources to create accessible interactive pdf forms. 

Until further notice, one suggestion is to provide users with an interactive Word form and a 

pdf version of the form that can be printed off and manually completed and posted. 

You must remember to inform users of both versions and what they can do with them. For 

example, if you are emailing the form to a user, then you must attach both the Word and 

the pdf versions, and include the following in the body of the email, e.g., 

“Please find two versions of the form attached. You may either: a) Complete the Word 

form electronically and email this back to (email address), or b) Print the pdf form, 

complete it and return to us in the post at (address).” 

Similarly, if you are attaching your form onto a web page, you should include the 

following, e.g.,  

“Please choose one of the following formats: 

 Nomination form (docx, 52 KB) - Complete the Word form electronically and email this 

back to (email address). 

 Nomination form (pdf, 48 KB) - Print the pdf form, complete it and return to us in the 

post at (address).” 

http://www.bradford.ac.uk/lss/documentation/#Wordprocessing
http://www.bradford.ac.uk/lss/feedback.php
mailto:web-team@bradford.ac.uk
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ADDING THE DEVELOPER TAB 

The form tools are available within the Developer tab. If you don‟t see it on the ribbon, you 

will need to add it. 

  

1. Click on the Office button.  

2. Click on Word Options. 

3. In the Popular tab, place a tick in the Show Developer tab in Ribbon box. 

4. Click on OK. 

DESIGN THE LAYOUT OF THE FORM 

Always use the built-in heading styles in Word to 

mark up sections. 

It is better to avoid the use of tables for the layout of 

forms, as these may not work well with screen 

readers. However you may use borders to create 

the impression of table cells if you wish: 

1. Highlight the text for which you wish to create a 

border. 

2. Click on the Borders button in the Paragraph 

group on the Home tab. 

3. Select Outside Borders. 

You may also use the columns feature for layout 

purposes. More about using columns and heading 

styles etc. can be found in the document „Making 

Microsoft Word 2007 Documents Accessible‟ at 

www.bradford.ac.uk/lss/documentation/#Wordprocessing. 

THE DEVELOPER TAB CONTROLS 

In order to ensure your form is accessible to 

screen readers, only use the Legacy Forms 

controls (click on the Legacy Tools button within 

Controls group). Do not use the other controls 

displayed.  

 

http://www.bradford.ac.uk/lss/documentation/#Wordprocessing
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Note: You can add the Legacy Tools to your Quick Access Toolbar by right-clicking the 

Legacy Tools button and choosing Add to Quick Access 

Toolbar. 

1. Ensure the Design Mode button is active in the Controls 

group before creating your form. 

Inserting a Text Form Field 

This button will add a field allowing the user to input text. 

1. Type in the form field label, e.g. First Name: 

2. Press the space bar and then click on the Text Form Field button within 

Legacy Tools. 

3. Double-click the inserted field (or highlight the field, right click and choose Properties). 

Here you can: 

 Select the type of text (regular, number, 

date etc.). 

 Insert default text to display within the field 

(e.g. „First name goes here‟ – this isn‟t 

mandatory). 

 Specify the maximum length of the input, 

in characters (e.g. setting this to 4 would 

allow inputting „Barr’, but not „Barry’). 

 Select the text format (e.g. Uppercase). 

 Run macro on – using macros is beyond the scope of this document. 

Note: You can also format the field by highlighting it and formatting it directly, e.g. right 

click and choose Italic from the Font option. This means when a user fills out the 

form, the input will be appear as italic. 

 Rename the default bookmark (you should insert the same text as the form 

field label, e.g. FirstName (no spaces are allowed in bookmark fields). 

Bookmarks are an aid to navigation throughout the form, for all users. 

 Tick or un-tick the Fill-in enabled box (if you un-tick this, it means that a user 

will not be able to type into this form field 

after the form is protected). 

 Calculate on exit – please see the 

section on Performing Calculations. 

 Add Help Text – Status Bar tab (this is 

essential to make the form accessible to 

blind users who use screen reader 

software to listen to the form and interact 

with it. Screen readers will not read any 

text outside of the form fields once the 
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form is protected, i.e. form headings, paragraphs etc. The user is likely to hear 

only “Edit ...edit ...edit” if no help text has been added to the field, making it 

impossible to comprehend what information is required of them. It is therefore 

vital that you add good, explanatory help text, e.g. for the First Name form field, 

the help text might read Insert your first name).  

Inserting a Check Box Form Field 

This button will add a check box to your form. If you wish to allow only one check box to 

be selected, it is better to insert a drop-down field instead (see next section). 

1. Type in the form field label, e.g. Student:  

2. Press the space bar and then click on the Check Box Form Field button 

within Legacy Tools.  

3. Double-click the inserted field (or highlight the field, right click and choose Properties). 

Here you can:  

 Specify the check box size. 

 Specify the default value (checked or not 

checked). 

 Run macro on – using macros is beyond 

the scope of this document. 

 Rename the default bookmark (you 

should insert the same text as the form 

field label, e.g. Student (no spaces are 

allowed in bookmark fields). Bookmarks 

are an aid to navigation throughout the 

form, for all users. 

 Tick or un-tick the Check box enabled box (if you un-tick this, it means that a 

user will not be able to check this box after the form is protected). 

 Calculate on exit – please see the section on Performing Calculations. 

Add Help Text – Status Bar tab (this is 

essential to make the form accessible to 

blind users who use screen reader software 

to listen to the form and interact with it. It is 

therefore vital that you add good, explanatory 

help text, e.g. for the Student check box field, 

the help text might read Student? Yes. The 

help text for a Staff label would be Staff? 

Yes). 

Note:  It is also a good idea to add extra advice in 

check box form fields. Click on the Help Key (F1) tab and enter: Use the space bar 

to check or uncheck check boxes. 
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Inserting a Drop-Down Field 

This button will add a drop-down list of choices to your form. (Be aware that if users print 

off the Word form to fill out manually, then this option is not appropriate and you should 

use check box form fields instead). 

1. Type in the form field label, e.g. Status:  

2. Press the space bar and then click on the Drop Down Form Field button 

within Legacy Tools.  

3. Double-click the inserted field (or highlight the field, right click and choose Properties). 

Here you can:  

 Add your choices to the drop-down item 

field (type in your choice and click on the 

Add button. Repeat until all of your choices 

appear in the box on the right – you can re-

order these, or remove them as you wish). 

 Run macro on – using macros is beyond 

the scope of this document. 

 Rename the default bookmark (you should 

insert the same text as the form field label, 

e.g., Status (no spaces are allowed in 

bookmark fields). Bookmarks are an aid to navigation throughout the form, for 

all users. 

 Tick or un-tick the Drop-down enabled box (if you un-tick this, it means that a 

user will not be able to choose from the drop-down list after the form is 

protected). 

 Calculate on exit – please see the 

section on Performing Calculations. 

 Add Help Text – Status Bar (this is 

essential to make the form accessible to 

blind users who use screen reader 

software to listen to the form and 

interact with it. It is therefore vital that 

you add good, explanatory help text. 

Drop-down boxes are read differently by 

screen readers than text fields or check 

boxes. In this case the help text should read Choose your status from the list). 

Note:  It is also a good idea to add extra advice in drop-down form fields. Click on the 

Help Key (F1) tab and enter: Press alt + down arrow to open a list of choices. Press 

up or down arrow to move through the options, and press ENTER to select the one 

you want.  
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Frames 

Frames are used as a way of organising or grouping form fields. However, there are some 

accessibility issues around the use of frames and it is therefore advisable not to use them.  

Form Field Shading 

Having the form field shading active (grey) on the form helps 

the user to see where inputs are needed. This shading will not 

display on printed copies. You are able to de-activate the 

shading (so it appears white, or whatever colour you have 

designated for the page) by clicking on the Form Field Shading button within Legacy 

Tools.  

INSTRUCTIONAL TEXT 

It is best to try to keep instructional text to a minimum, and only include if absolutely 

necessary. 

This is very important, for the following reason: once you protect the form (this is covered 

later in the document), the screen reader will not read any of the text outside of the form 

fields.  

In the following example, only the form field help text that has been inserted will be read 

out. The text All information collected is confidential and Name: will NOT be read. 

All information collected is confidential 

Name:       

Therefore, if you have important information outside of the form fields, this will be missed 

once the form is protected.  

There are two ways to resolve this issue: 

Method 1 – Minimal Instructional Text 

This is the most reliable method. 

If the instructional text is minimal, it can be added 

to the help text at the beginning of form field 

inputs. For example, if you have a single 

sentence of instructional text at the beginning of 

the form, then you could include the instructional 

text in the help text for the first form field. A 

screen shot is included here as an example.  
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Method 2 – A Lot of Instructional Text 

This is a less reliable method than Method 1 above. 

If quite a lot of instructional text is necessary, you could create continuous section breaks 

in your form, and then protect only the sections that contain the form fields. (More about 

using section breaks can be found in the document „Long Document and Report Writing in 

Microsoft Word 2007‟ at www.bradford.ac.uk/lss/documentation/#Wordprocessing.) 

If you adopt this method, it is vital that you inform the screen reader user to navigate the 

form using the arrow keys on the keyboard and not the Tab key. This can be achieved by 

including a Text Form Field in a protected section at the very beginning of the form, with a 

maximum length of 1 character, and inserting the following text to the Add Help Text box: 

Field for information only. Navigate the form using keyboard arrow keys (not the tab key), 

as information appears outside form fields. 

Ensure that you place your cursor just before this text form field before protecting 

your form. 

 

Also, if you use section breaks for this purpose, do not use columns to lay out your form. 

PERFORMING CALCULATIONS 

You can make calculations automatically based on the 

numbers input by users. 

1. In the Properties for each of the input fields where 

the user will type in a number, ensure that you set 

the Type to Number.  

2. Note down the names of the bookmarks as you will 

need them later. 

3. Tick the Calculate on exit box. 

4. Click on OK. 

5. In the Properties for the field in which you wish the 

calculation to be made automatically, set the Type 

to Calculation.  

6. Set the Number format to £#,##0.00;(£#,##0.00). 

7. In the Expression box, you need to set the 

http://www.bradford.ac.uk/lss/documentation/#Wordprocessing
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function for the calculation, beginning with the symbol =. For example, if this field is to 

display the total of the sum of two other fields, then you would type in:  

=sum(accommodation,travel) - note the use of the names of the bookmarks.  

If you wish to make a multiplication calculation, then an example might be: 

=licences*95 - where licences is the name of the bookmark for the field asking for the 

number of licences required, 95 would be the cost of the individual licence and * is the 

symbol for multiplication. 

Note:  You do not need to add Help Text to the automatic calculation field. 

TESTING THE FORM 

Once you have completed your form you should test it. Users will not be able to use the 

form fields until you have protected the form. To do this: 

1. Ensure the Design Mode is turned off in the Controls group. 

2. Click on the Developer tab and then Protect Document. 

3. Click on Restrict Formatting and Editing. 

4. Place a tick in the box next to Allow only this type of 

editing in the document. 

5. Select Filling in forms from the drop-down list. If you have 

included continuous section breaks to separate instructional 

text from the form fields (see the previous section - 

Instructional Text), click on Select sections... and tick the 

box next to each of the sections that contain the form fields.  

6. Click on Yes, Start Enforcing Protection. 

7. Don‟t enter a password, and click on OK. 

8. Tab through the fields and complete the form. 

After testing the form you can reset the form fields. First remove the protection: 

1. Click on the Developer tab and then Protect Document. 

2. Click on Restrict Formatting and Editing. 

3. Click on Stop Protection. 

Then reset the form fields: 

1. Click on the Developer tab. 

2. Click on the Legacy Tools button. 

3. Click on Reset Form Fields. 
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PROTECTING THE FORM 

You may wish to protect the form so that the user cannot alter any of the text outside of 

the input fields. However, there is another reason why you should always protect the form. 

It is the protection that activates the input fields and enables the help text for each field to 

be read by a screen reader. Without the protection, the form is rendered useless for a 

screen reader user. 

1. Ensure the Design Mode is turned off in the Controls group. 

2. Click on the Developer tab and then Protect Document.  

3. Click on Restrict Formatting and Editing. 

4. Place a tick in the box next to Allow only this type of 

editing in the document. 

5. Select Filling in forms from the drop-down list. If you 

have included continuous section breaks to separate 

instructional text from the form fields (see the previous 

section - Instructional Text), click on Select sections... 

and tick the box next to each of the sections that contain 

the form fields. 

6. Click on Yes, Start Enforcing Protection. 

7. Enter a password, and again to confirm (a password is not 

mandatory here – you could simply click on Ok, however, people will be able to make 

changes to the form if they know how to disable the protection). 

8. Click on OK. 

Note: It is critical that you make a note of the password if one is used – there is no way to 

retrieve the form in its original state in order to make amendments etc. without this 

password. 

 

The spell check facility does not work for users of the form, once it is protected. 

However, users may type their content into another Word document, spell check it 

there, amend as necessary and then copy this text and paste it into the form field. 

PUBLISHING THE FORM 

Please read the section Alternative Formats at the beginning of the guide. 

Be aware that users will not be able to format any text they type in to the form, e.g., make 

paragraphs into a list, or apply italics etc. Also, they will not be able to use the spell check 

facility. However, they would be able to type up their content into another Word document, 

spell check it there, and then paste it into the form fields. Make users aware of this if 

appropriate. 
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COLLECTING FORM DATA 

You are able to save data on a form to a text file, which can then be imported into an 

Excel spreadsheet, or an Access database. 

Saving Form Data to a Text File 

1. Open the completed Word form. 

2. Click on the Office button and then Word Options. 

3. Click on the Advanced tab. 

4. Scroll down to the Preserve fidelity when sharing this document section. 

5. Tick the Save form data as delimited text file box and click on OK. 

6. Click on the Office button and then Save Copy As.... 

7. Save the file as a Plain Text file and click on OK. 

Importing Data into an Excel Spreadsheet 

1. Open up an Excel spreadsheet and click on 

the Data tab. 

2. Find the Get External Data group and click on 

the From Text button. 

3. Locate your plain text file and click on Import. 

4. Ensure the file type is set to Delimited and 

click on Next. 

5. Under Delimiters, place a tick in the Comma 

box, ensure any other ticks are removed and click on Next. 

6. Format each individual column as you wish (not mandatory) and click on Finish. 

7. Ensure the cell reference is correct for where you wish the data to appear and click on 

OK. 

8. The data should now be imported. You can insert a new row above if you wish, and 

put in column headers. 

9. Save the Excel spreadsheet. 

You can to import the data from more than one form into this spreadsheet. Simply follow 

the instructions as above for each form, using the same spreadsheet. There is however 

one important point to note: each time you import the data from a new form, you will not 

be able to import it into the next blank row in your spreadsheet. It will not allow this. 

Therefore, you will need to leave a blank row each time and then delete the blank rows 

later if you wish. 
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Importing Data into an Access Database 

1. Open up a blank Access database. 

2. Click on the External Data tab, find the Import group, and click on the Text File 

button. 

3. Browse for and open your plain text file. 

4. Select Import the source data into a new table in the current database and click 

on OK. 

5. Ensure the file type is set to Delimited and click on Next. 

6. Under Delimiters, place a tick in the Comma box, ensure any other ticks are removed 

and click on Next. 

7. For each column, specify a field name and select the data type and click on Next. 

8. Select Choose my own primary key and select the column you wish to be the 

primary key. 

9. Click on Next. 

10. Enter a name for the table and click on Finish. 

11. Click on Close. 

To add the data for the next form: 

12. Open up your database. 

13. Click on the External Data tab, find the Import group, and click on the Text File 

button. 

14. Browse for and open your plain text file for the new form. 

15. Select Append a copy of the records to the table: and select the table you created 

above. 

16. Click on Ok. 

17. Ensure the file type is set to Delimited and click on Next. 

18. Under Delimiters, place a tick in the Comma box, ensure any other ticks are removed 

and click on Next. 

19. Click on Finish. 

20. Click on Close. 
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